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Abstract 

According to how soccer robot movement is controlled, approaches in soccer robot can be divided into two categories, 

namely centralized and decentralized. Centralized approach is an example of control over network concept where devices 

are controlled over the network. Each robot obtains information from a vision system outside the robot to detect the ball, and 

the central computer makes decision on which robot to approach and kick the ball. Wireless communication between robot 

and central computer must be reliable. One of the most important components in soccer robot is the ball kicking mechanism, 

which has to be able to kick the ball accurately. The wireless communication system is developed with a WeMos D1 

microcontroller. Ball kicking mechanism is developed using solenoid circuit controlled by the microcontroller. Testing 

showed that wireless communication system has 100% reliability when operated in range up to 300cm. The ball kicking 

mechanism was able to respond accurately to ball kicking command when the robot is stationary and moving. When the 

robot is stationary, average kicking distance of the ball is 42.22cm and average tilt angle is 29.58°. When robot is moving, 

average kicking distance is 40.98cm and average tilt angle is 26.12°. 

Keywords: Soccer Robot, Wireless Communication System, Ball Kicking Mechanism, Microcontroller  

Abstrak 

Berdasarkan bagaimana mengendalikan gerak robot sepak bola, pendekatan dalam robot sepak bola dapat dibagi menjadi dua 

kategori, yaitu tersentralisasi dan terdesentralisasi. Pendekatan tersentralisasi merupakan contoh dari konsep control over 

network, dimana semua komponen dikendalikan melalui sebuah jaringan. Setiap robot mendapatkan informasi dari sistem 

visi di luar robot untuk mendeteksi bola, kemudian komputer sentral sebagai pengendali akan membuat keputusan untuk 

menentukan robot mana yang akan mendekat dan menendang bola. Komunikasi antara robot dan komputer sentral bersifat 

nirkabel dan diharapkan memiliki reliabilitas tinggi. Salah satu komponen penting pada robot sepak bola adalah rangkaian 

penendang bola. Rangkaian penendang bola diharapkan dapat merespon perintah untuk menendang bola dengan tepat dan 

akurat. Sistem komunikasi nirkabel untuk mengendalikan gerak robot sepak bola dirancang menggunakan mikrokontroler 

WeMos D1. Rangkaian penendang bola dirancang menggunakan rangkaian solenoid yang dikendalikan oleh mikrokontroler. 

Pengujian menunjukkan sistem komunikasi nirkabel memiliki reliabilitas 100% untuk jarak sampai dengan 300cm. 

Rangkaian penendang dapat merespon dengan baik terhadap perintah menendang bola, baik dari posisi robot tidak bergerak 

maupun posisi robot bergerak. Pada posisi robot tidak bergera, robot dapat menendang bola hingga mencapai jarak rata-rata 

42.22cm dan kemiringan bola rata-rata 29.58°. Pada posisi robot bergerak, jarak rata-rata tendangan adalah 40.98cm dan 

kemiringan bola rata-rata 26.12°. 

Kata kunci: Robot Sepak Bola, Sistem Komunikasi Nirkabel, Mekanisme Menendang Bola, Mikrokontroler 
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1. Pendahuluan 

Robot sepak bola adalah sekelompok robot yang dapat 

bermain sepak bola sebagai sebuah tim, untuk melawan 

tim robot sepak bola lain dalam sebuah arena berupa 

lapangan sepak bola. Berdasarkan bagaimana 

mengendalikan gerak robot sepak bola, pendekatan 

dalam robot sepak bola dapat dibagi menjadi dua 

kategori, yaitu pendekatan tersentralisasi [3,4,5,12] dan 

terdesentralisasi [1,2]. Pada pendekatan tersentralisasi, 

setiap robot mendapatkan informasi dari sistem visi 

yang berada di luar robot untuk mendeteksi bola, 

kemudian komputer pengendali yang berperan sebagai 

sentral akan membuat keputusan untuk menentukan 

robot mana yang akan mendekati dan mengoper, 

menendang atau mendribel bola. Pada pendekatan 

terdesentralisasi, setiap robot dilengkapi dengan sistem 

visi untuk mendeteksi, mengoper, menendang atau 

mendribel bola. Paper ini akan berfokus pada 
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pendekatan tersentralisasi yang merupakan contoh dari 

konsep control over network, dimana semua komponen 

dikendalikan melalui sebuah jaringan. Konsep tersebut 

dapat diterapkan dalam berbagai jenis aplikasi, seperti 

pada [21]. 

Pengembangan sistem robot sepak bola menggunakan 

pendekatan tersentralisasi adalah permasalahan yang 

kompleks yang melibatkan berbagai disiplin ilmu. 

Pengolahan citra diperlukan untuk mendapatkan 

informasi dari lapangan sepak bola. Pada [4,5], citra 

lapangan sepak bola yang diperoleh akan diproses pada 

komputer untuk menentukan gerakan yang dilakukan 

oleh masing-masing robot. Pengambilan keputusan 

tersebut membutuhkan kecerdasan buatan atau teknik 

pendukung pemilihan keputusan yang dibahas pada 

[6,7,8,9]. Keputusan kemudian dikirim kepada robot 

melalui jaringan nirkabel seperti dibahas pada [19, 20]. 

Setelah menerima informasi, robot akan melakukan 

gerakan seperti yang diperintahkan. Supaya robot dapat 

merespon pada perintah, robot harus memiliki sistem 

gerak yang tepat dan akurat. Upaya untuk 

meningkatkan akurasi gerak robot dibahas pada 

[9,10,11]. Robot juga perlu memiliki rangkaian 

penendang yang akurat untuk dapat menendang bola 

dengan benar saat diperintah, yang dibahas pada [12]. 

Paper ini membahas mengenai desain sistem 

komunikasi nirkabel yang reliabel dan konsisten antara 

robot dan komputer, terutama memfokuskan pada 

kontrol gerak robot dan menendang bola. 

Mikrokontroler yang digunakan pada [9] adalah 

Arduino Yun untuk menghubungkan komputer dan 

robot dan mengendalikan robot, namun kebutuhan 

untuk komunikasi nirkabel secara reliabel tidak dapat 

terpenuhi dengan baik menggunakan mikrokontroler 

tersebut. Maka digunakan sebuah mikrokontroler lain 

dengan kemampuan komunikasi nirkabel, yaitu WeMos 

D1, sebagai unit pengendali utama pada robot. 

Mikrokontroler diinterfasi ke berbagai sistem pada 

robot sepak bola, dan pengujian dilakukan dengan 

memberi perintah dari komputer untuk robot bergerak 

dan menendang bola. Rangkaian penendang bola pada 

robot diimplementasikan menggunakan sebuah 

solenoid, dan diuji ketepatannya dalam menendang 

bola ke sasaran. 

2. Tinjauan Pustaka 

2.1. Mobile Robot 

Mobile robot atau robot bergerak dapat dibagi dalam 

dua kategori, yaitu robot berkaki (legged robot) atau 

robot beroda (wheeled robot). Penentuan cara gerak 

robot menggunakan kaki atau roda tergantung pada tiga  

isu utama, yaitu stabilitas, karakteristik dari titik 

kontak, dan jenis lingkungan tempat robot beroperasi. 

Robot beroda dapat dibagi lagi menjadi empat sub-

kategori berdasarkan jenis roda yang digunakan, yaitu 

standard wheel, castor wheel, Swedish atau mecanum 

wheel, dan spherical wheel, dimana setiap jenis 

memiliki karakteristik, kelebihan dan kekurangan 

terhadap jenis lainnya. Keempat jenis roda tersebut 

dapat dilihat pada Gambar 1, yaitu standard wheel (a), 

castor wheel (b), Swedish atau mecanum wheel (c), dan 

spherical wheel (d) [13]. 

 

Gambar 1. Berbagai kategori jenis roda 

Robot dapat dirancang untuk bergerak secara omni-

directional, yaitu dapat bergerak kapan saja ke arah 

mana saja tanpa tergantung orientasi robot terhadap 

sumbu vertikalnya. Pergerakan omnidirectional dapat 

dicapai dengan menggunakan castor, Swedish atau 

spherical wheel. 

Selain jenis roda, konfigurasi roda juga memiliki peran 

penting dalam menentukan performa robot dalam tiga 

kategori, yaitu stabilitas, manuverabilitas dan 

kontrolabilitas. Robot omnidirectional memiliki 

manuverabilitas yang tinggi [10,11] namun pada 

umumnya lebih sulit untuk dikontrol [13]. 

2.2 Mikrokontroler 

Mikrokontroler adalah sebuah komputer berukuran 

kecil dengan harga relatif murah, umum dipakai untuk 

keperluan spesifik seperti menampilkan informasi pada 

microwave LCD atau menerima perintah dari remote 

TV. Mikrokontroler umumnya digunakan pada produk 

yang membutuhkan kendali dari pengguna. 

Mikrokontroler umumnya dibuat menggunakan 

teknologi Complementary Metal Oxide Semiconductor 

(CMOS) sehingga hemat energi dan tahan terhadap 

perubahan daya.  

Mikrokontroler pada umumnya memiliki CPU, ROM, 

RAM dan beberapa port I/O untuk menjalankan tugas 

spesifik yang diberikan. Mikrokontroler umumnya 

diinterfasikan dengan perangkat-perangkat lain untuk 

memberi masukan ke mikrokontroler, seperti tombol 

atau sensor, dan menampilkan keluaran dari 

mikrokontroler, seperti LED atau LCD [16]. 
 

Mikrokontroler yang digunakan sebagai pengendali 

robot harus memiliki kemampuan untuk komunikasi 

nirkabel secara reliabel dan konsisten. Mikrokontroler 

Swedish 45°   Swedish 90° 
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yang digunakan pada [9] adalah Arduino Yun, namun 

mikrokontroler tersebut ditemukan memiliki masalah 

pada reliabilitas koneksi dengan komputer. Oleh karena 

itu, sebuah mikrokontroler jenis lain, yaitu WeMos D1, 

digunakan sebagai pengganti. WeMos D1 adalah papan 

mikrokontroler yang kompatibel dengan Arduino Uno 

dan berbasiskan mikrokontroler ESP8266EX yang 

memiliki kemampuan untuk berkomunikasi secara 

nirkabel, dapat menggunakan protokol 802.11b/g/n 

pada frekuensi 2.4Ghz [18]. WeMos D1 memiliki 11 

digital input/output pin, dimana semua pin kecuali pin 

D0 mendukung fitur interrupt, I2C, PWM dan one-

wire. Selain itu WeMos D1 juga memiliki satu analog 

input pin dengan maksimum input 3.2V, koneksi micro 

USB, power jack dengan 9-24V power input, dan 

kompatibilitas dengan Arduino dan nodeMCU [15]. 

Papan mikrokontroler WeMos D1 dapat dilihat pada 

Gambar 2. 

 
Gambar 2. WeMos D1 

 

Spesifikasi teknis dari mikrokontroler WeMos D1 

dapat dilihat pada Tabel 1. 

 
Tabel 1. Spesifikasi Teknis WeMos D1 

Microcontroller ESP-8266EX 

Operating Voltage 3.3V 

Digital I/O Pins 11 

Analog Input Pins 1(Max input: 3.2V) 
Clock Speed 80MHz/160MHz 

Flash 4M bytes 

Length 68.6mm 
Width 53.4mm 

Weight 25g 

Meskipun secara tampilan dan fitur WeMos memiliki 

banyak kesamaan dengan Arduino Uno, namun kedua 

mikrokontroler tersebut memiliki pinout yang berbeda. 

Tabel 2 adalah perbandingan antara pengalokasian pin 

Arduino Uno dengan WeMos D1. 

2.3. Solenoid  

Solenoid adalah sebuah elektromagnet yang terdiri dari 

sebuah kumparan dan sebuah batang besi yang bisa 

bergerak yang disebut armatur. Rangkaian solenoid 

dapat dilihat pada Gambar 3.  

Medan magnet akan terbentuk pada saat arus mengalir 

pada kabel. Jika kabel dililit mejadi kumparan, medan 

magnet akan menjadi beberapa kali lebih kuat. Ketika 

kumparan diailiri arus listrik, batang besi akan bergerak 

ke arah dalam untuk meningkatkan fluks dengan 

menutup celah udara antara armatur dan bagian dalam 

solenoid. Armatur memiliki pegas sehingga dapat 

kembali ke posisi semula saat arus dimatikan. Gaya 

yang dihasilkan berbanding lurus dengan kuadrat dari 

arus, dan berbanding terbalik dengan kuadrat dari lebar 

celah udara. 

Tabel 2. Perbandingan Pin Arduino Uno dengan WeMos D1 

 Arduino UNO  WeMos-D1R2 

 SCL I2C: SCL  GPIO05 I2C: 

SCL 

 SDA I2C: SDA  GPIO04 I2C: 
SDA 

 AREF     

 GND   GND  
 GPIO13 SPI: SCK  GPIO14 SCK 

 GPIO12 SPI: MISO  GPIO12 MISO 

 GPIO11 SPI: MOSI  GPIO13 MOSI 

 GPIO10 SPI: SS  GPIO15 SS 

 GPIO9   GPIO13  
 GPIO8   GPIO12  

 GPIO7   GPIO14  

 GPIO6   GPIO2  
 GPIO5   GPIO0  

 GPIO4   GPIO04  

 GPIO3   GPIO05  
 GPIO2   GPIO16  

 GPIO1 TX  GPIO01 TX0 

 GPIO0 RX  GPIO03 RX0 

 

Gambar 3. Solenoid 

Solenoid banyak digunakan pada kehidupan sehari-hari, 

misalnya pada katup mesin cuci, mesin fotokopi, 

pengunci pintu, otomasi pabrik, dan lain-lain. Pada 

robot sepak bola, rangkaian solenoid digunakan sebagai 

komponen penendang bola.[17] 

2.4. Penelitian Sebelumnya 

Desain omni-directional robot pada [9] menggunakan 

empat DC Motor PG22 yang diletakkan secara 

diagonal dengan pergeseran fase sebesar 90° antar satu 

sama lain. Setiap motor terhubung ke sebuah omni 

wheel, yaitu sebuah tipe roda yang sejenis dengan 

Swedish wheel yang dijelaskan pada bagian 2.1. Desain 

robot sepak bola tersebut dapat dilihat pada Gambar 4. 

Robot menggunakan sebuah Xiaomi Powerbank 

5200mAh dan dua Li-Ion 12V Battery Pack sebagai 

catu daya. Sebuah Arduino Yun digunakan sebagai 

pengendali dari semua perangkat keras robot, dan untuk 

berkomunikasi dengan komputer secara nirkabel. 
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Sebuah MPU6050 berfungsi sebagai accelerometer dan 

gyroscope untuk mengukur sudut kemiringan gerak 

robot. Dua L298N motor driver digunakan untuk 

mengendalikan masing-masing dua DC motor, dan 

sebuah solenoid digunakan untuk menendang bola. 

Diagram sistem dari robot sepak bola dapat dilihat pada 

Gambar 5. 

 

Gambar 4. Desain Robot Sepak Bola [9] 

 

 

Gambar 5. Diagram Sistem Robot Sepak Bola [9] 

3.  Metodologi Penelitian 

Tahap awal penelitian adalah studi literatur melalui 

berbagai sumber seperti buku, jurnal, prosiding, 

disertasi, dan situs web. Informasi yang dikumpulkan 

berupa penelitian sebelumnya yang berkaitan dengan 

pengembangan robot sepak bola dan berbagai 

komponen dan perangkat didalamnya. Selain itu juga 

referensi mengenai mobile robot, mikrokontroler, dan 

solenoid dikumpulkan dan diolah untuk 

mengembangkan sistem yang akan dibuat pada 

penelitian ini. Review teknologi juga dilakukan pada 

perangkat mikrokontroler untuk menentukan jenis 

mikrokontroler yang akan digunakan pada penelitian 

berdasarkan kapabilitas dan spesifikasi dari 

mikrokontroler dan mencocokkan pada kebutuhan 

penelitian. Lalu dilakukan rancang bangun perangkat 

keras rangkaian penendang bola menggunakan 

mikrokontroler, solenoid dan perangkat keras lainnya, 

rancang bangun perangkat lunak untuk mengendalikan 

kerja perangkat keras tersebut, serta rancangan sistem 

komunikasi robot dan komputer. 

Rancangan sistem tersebut lalu diimplementasikan dan 

diuji reliabilitas komunikasi nirkabel dan penendang 

bola, dan hasilnya dianalisis untuk menentukan apakah 

sistem yang dirancang sudah dapat memberikan hasil 

yang diharapkan atau belum. 

4.  Hasil dan Pembahasan 

4.1. Konfigurasi WeMos D1 

WeMos D1 dapat diprogram menggunakan software 

Arduino IDE, namun perlu dilakukan beberapa 

konfigurasi supaya WeMos dapat dikenali oleh 

Arduino IDE, dan kode program yang dibuat di 

Arduino IDE dapat diunggah ke WeMos. Library 

ESP8266 dimasukkan ke Arduino IDE dengan 

membuka File -> Preferences, lalu memasukkan 

alamat situs web berikut: 
http://arduino.esp8266.com/stable/pac

kage_esp8266com_index.json pada kolom 

“Additional Boards Manager URLs”, seperti pada 

Gambar 6. 

 

Gambar 6. Menambahkan Library ESP8266 ke Arduino IDE 

ESP8266 akan terdaftar pada Boards Manager, yang 

dapat diakses dari Tools -> Board -> Boards Manager 

pada Arduino IDE. Instalasi dilakukan dengan memilih 

install “esp8266 by ESP8266 Community” pada 

Boards Manager, seperti pada Gambar 7. 

Setelah instalasi, WeMos D1 akan muncul pada daftar 

board yang tersedia di Tools -> Board seperti pada 

Gambar 8. 

Port dan upload speed WeMos dapat diatur seperti 

halnya pada mikrokontroler Arduino. Gambar 9 

menunjukkan contoh mengatur upload speed menjadi 

921600 dan memilih port COM1 sebagai port 

komunikasi WeMos. 
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Gambar 7.Tampilan setelah Instalasi Board ESP8266 

Gambar 8. Memilih Board WeMos D1 

Gambar 9. Mengatur Port dan Upload Speed 

Setelah konfigurasi port dan upload speed, WeMos D1 

sudah dapat diuji dengan menggunakan program 

sederhana seperti program untuk menyalakan atau 

mematikan LED. Perlu dicatat bahwa pin untuk 

mengakses LED pada WeMos berbeda dengan pin 

LED pada Arduino, yaitu pin 14 dan pin 2. 

4.2. Komunikasi Nirkabel WeMos D1 dan Komputer 

Setelah konfigurasi awal WeMos D1 berhasil dilakukan 

pada bagian 4.1, WeMos dapat diprogram supaya dapat 

berfungsi sebagai HTTP server untuk melakukan 

komunikasi nirkabel dengan komputer pengendali. 

Komunikasi dapat dilakukan dengan membuat program 

pada Arduino IDE untuk melakukan inisialisasi HTTP 

server pada port 80, lalu melakukan pengaturan SSID 

dan password dari jaringan nirkabel yang akan dibuat 

pada WeMos. Setelah program diunggah ke WeMos, 

WeMos dapat dilepaskan dari komputer dan 

dihubungkan ke sumber listrik lain seperti baterai atau 

powerbank. WeMos akan memancarkan jaringan 

nirkabel dengan SSID dan password sesuai konfigurasi.  

Langkah berikutnya adalah melakukan koneksi dari 

komputer ke jaringan WeMos, dan membuat program 

untuk menampilkan alamat IP dari WeMos ke serial 

monitor. WeMos sudah terkonfigurasi untuk 

menggunakan alamat IP default yaitu 192.168.4.1. 

Gambar 10 adalah hasil dari program untuk mencetak 

alamat IP WeMos ke serial monitor. 

Gambar 10. Alamat IP WeMos server pada Serial Monitor 

WeMos dapat diprogram supaya menampilkan sebuah 

halaman web apabila alamat IP tersebut dimasukkan ke 

web browser. Halaman web dapat dibuat menggunakan 

sintaks bahasa HTML dan javaScript untuk 

mengendalikan berbagai fitur pada WeMos. Gambar 11 

merupakan sebuah program sederhana untuk menguji 

komunikasi nirkabel antara WeMos dan komputer, 

dengan sebuah web interface sederhana berupa dua 

tombol untuk menyalakan atau mematikan LED pada 

WeMos. 

 
Gambar 11. Program menyalakan dan mematikan LED WeMos 

4.3. Pengujian Komunikasi Nirkabel 

Komunikasi nirkabel antara WeMos dan komputer diuji 

menggunakan kode program yang dibuat pada bagian 

4.2 untuk menentukan apakah jarak operasi dan 
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reliabilitas dari WeMos sudah memenuhi syarat untuk 

dipakai pada robot sepak bola. Pengujian dilakukan 

dengan menempatkan WeMos pada jarak 50cm, 

100cm, 150cm dan 200cm dari komputer dan 

mengirimkan pesan LED ON/OFF sebanyak 10 kali 

pada masing-masing jarak. Pengujian dinyatakan 

berhasil apabila WeMos berhasil merespon dengan 

menyalakan atau mematikan LED sesuai perintah dari 

komputer. Hasil pengujian dapat dilihat pada Tabel 3. 

Tabel 3. Hasil Pengujian Komunikasi Nirkabel 

 No Jarak 

(cm) 

Jumlah 

Pengujian 

Pengujian 

Berhasil 

Persentase 

Keberhasilan 

 1 50 10 10 100% 
 2 100 10 10 100% 

 3 150 10 10 100% 

 4 200 10 10 100% 
 5 250 10 10 100% 

 6 300 10 10 100% 

Tabel 3 menunjukkan bahwa tingkat keberhasilan dari 

seluruh pengujian untuk jarak 50 hingga 300cm adalah 

100%, sehingga dapat disimpulkan bahwa jaringan 

Wifi dari WeMos sangat reliabel dan dapat digunakan 

sebagai media komunikasi melalui jaringan pada robot 

sepak bola. 

4.4. Rangkaian solenoid lock 

Solenoid membutuhkan arus yang jauh lebih besar 

daripada arus maksimum yang dapat dikeluarkan dari 

pin mikrokontroler WeMos D1, yaitu sekitar 40mA, 

sehingga untuk mengontrol solenoid lock dibutuhkan 

rangkaian penguat arus dengan menggunakan sebuah 

TIP120 power transistor. Transistor akan diberi daya 

dari baterai Li-ion 12V yang dipakai sebagai catu daya 

robot. Rangkaian juga menggunakan sebuah dioda 

yang berfungsi untuk menghambat tegangan balik yang 

dapat merusak rangkaian. Rangkaian solenoid lock 

untuk menendang bola dapat dilihat pada Gambar 12. 

Rangkaian akan dipasang diantara dua omni wheel pada 

posisi kiri atas dan kanan atas dari robot sepak bola 

pada Gambar 4. 

Gambar 12. Rangkaian solenoid lock untuk menendang bola 

4.5. Pengujian Rangkaian Menendang Bola 

Rangkaian menendang bola yang dirancang pada 

bagian 4.4 akan diuji dengan dua jenis pengujian 

dengan sebuah bola pingpong standar dengan diameter 

40mm. Pengujian pertama adalah memberi perintah 

pada mikrokontoler WeMos secara nirkabel untuk 

membuat robot menendang bola pingpong dari posisi 

robot tidak bergerak sebanyak lima kali, 

membandingkan posisi bola awal (sebelum ditendang) 

dan akhir (setelah ditendang), lalu mengukur perubahan 

jarak dan arah gerak bola. Bola dan robot diuji pada 

sebuah bidang datar dua dimensi berukuran 

200x200cm. Posisi bola dinyatakan dalam koordinat 

kartesius (x,y), dimana titik (0,0) adalah titik paling 

ujung kiri bawah dari bidang datar tersebut apabila 

dilihat dari atas. Jarak dan sudut perpindahan bola 

diukur menggunakan rumus jarak dan sudut seperti 

berikut: 

      √
(     )  

(     )  
            ( ) 

           (
     

     
)      ( ) 

Dimana (x1,y1) adalah nilai koordinat (x,y) dari titik 

awal posisi bola yang dinyatakan dalam sistem 

koordinat kartesius, dan (x2,y2) adalah nilai koordinat 

(x,y) dari titik akhir posisi bola yang dinyatakan dalam 

sistem koordinat kartesius. Hasil pengujian pertama 

dapat dilihat pada Tabel 4. 

Tabel 4. Pengujian menendang bola dari posisi robot tidak bergerak 

No Posisi 

Bola Awal 

Posisi 

Bola Akhir 

Jarak 

(cm) 

Sudut 

Kemiringan (°) 

X1 Y1 X2 Y2 

1 30 30 71 41 42.45 15.02 
2 30 30 71 5 48.02 -31.37 

3 30 30 52 0 37.20 -53.75 

4 30 30 60 0 42.43 -45 
5 30 30 71 28 41.05 -2.79 

 

Dari tabel 4 ditemukan bahwa sistem penendang dapat 

menendang bola dengan cukup baik dari posisi tidak 

bergerak, dapat mencapai jarak yang cukup jauh dalam 

menendang dengan rata-rata jarak 42.22 cm. Namun 

bola memiliki kecenderungan untuk tidak bergulir lurus 

dan bergulir ke samping kiri atau kanan setelah 

ditendang, dengan rata-rata kemiringan absolut adalah 

29.58°.  

Pengujian kedua adalah menendang bola dari posisi 

robot bergerak sebanyak lima kali, membandingkan 

posisi bola awal dan akhir, lalu mengukur perubahan 

jarak dan arah gerak bola. Robot akan dikendalikan 

dari komputer untuk bergerak mendekati posisi bola. 

Hasil pengujian dapat dilihat pada Tabel 5. 

Tabel 5 menunjukkan bahwa robot dapat menendang 

bola dengan cukup baik dari posisi bergerak. Rata-rata 

jarak yang diperoleh dari tendangan adalah 40.98 cm, 

dan rata-rata kemiringan bola setelah ditendang adalah 

26.12°. 
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Tabel 5. Pengujian menendang bola dari posisi robot bergerak 

No Posisi 
Robot 

Awal 

Posisi 
Bola Awal 

Posisi 
Bola 

Akhir 

Jarak 
(cm) 

Sudut 
Kemir 

ingan 

(°) Xr Yr X1 Y1 X2 Y2 

1 0 30 30 30 73 4 50.25 -31.16 
2 15 43 30 30 53 2 36.24 -50.60 

3 0 15 30 30 67 45 39.93 22.07 

4 15 15 30 30 60 42 32.31 21.80 
5 0 42 30 30 76 26 46.17 -4.97 

Kedua pengujian tersebut menunjukkan bahwa 

rangkaian penendang dapat menendang bola untuk 

mencapai jarak yang cukup baik, namun sudut 

kemiringan dari tendangan bola masih cukup besar 

sehingga akurasi tendangan masih belum cukup akurat.  

Rangkaian menendang bola yang sudah dipasang pada 

robot dapat dilihat pada Gambar 13. 

Gambar 13. Rangkaian menendang bola 

5.  Kesimpulan 

5.1. Simpulan 

Telah dibuat sebuah sistem komunikasi nirkabel untuk 

mengendalikan robot sepak bola untuk bergerak dan 

menendang bola. Sistem berhasil melakukan 

komunikasi nirkabel dengan tingkat reliabilitas 100% 

untuk jarak komunikasi sampai dengan 300cm, 

sehingga dapat disimpulkan bahwa komunikasi 

nirkabel dapat dilakukan secara akurat dan reliabel 

menggunakan mikrokontroler WeMos D1 sebagai 

pengendali. 

Rangkaian penendang bola sudah dapat menendang 

bola dengan cukup baik, baik dari posisi robot diam 

maupun bergerak. Bola yang ditendang dapat mencapai 

jarak yang cukup baik, dengan rata-rata 42.22cm dari 

posisi robot tidak bergerak dan 40.98cm dari posisi 

robot bergerak kedua percobaan, namun akurasi 

tendangan masih belum terlalu baik karena rata-rata 

kemiringan bola adalah 29.58° untuk posisi robot tidak 

bergerak, dan 26.12° untuk posisi robot bergerak. 

5.2. Saran 

Untuk meningkatkan kinerja dan akurasi dari sistem 

penendang bola pada robot, dapat dipertimbangkan 

untuk memperlebar bidang dari solenoid yang 

digunakan untuk menendang bola. Bidang yang lebih 

besar akan mempermudah robot untuk menahan bola 

(trap) sebelum ditendang supaya bola berada dalam 

posisi stabil, sehingga tendangan yang dihasilkan akan 

lebih akurat.  

Untuk komunikasi nirkabel, sistem perlu 

dikembangkan dan diuji pada situasi mengendalikan 

lebih dari satu robot. Sistem yang dikembangkan pada 

paper ini menggunakan mikrokontroler yang dipasang 

pada robot sebagai sumber dari jaringan nirkabel untuk 

komunikasi komputer dengan robot, namun untuk 

pengendalian lebih dari satu robot perlu diuji apakah 

jaringan tersebut tetap reliabel saat semua robot sedang 

aktif bergerak. 
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